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Preface

This document describes how to install the DSNlink Version 3.0 software on an
Alpha™ system that runs Compaq Tru64 UNIX.

Overview
The DSNlink software is a service tool that provides electronic communication
capabilities between customers’ systems and a Compaq Customer Support Center.
Using DSNlink, customers can send electronic service requests and receive help
from Compaq specialists. Customers can also use DSNlink to search Compaq’s
technical support databases for information about products for which they have
service contracts.

The installation procedure creates DSNlink file systems subordinate to the
/usr/lib/dsn/ directory and loads DSNlink software subsets.

You can install DSNlink on a local node or from a Remote Installation Services
(RIS) server area.

Keep this document with your distribution kit. You will need it to install
maintenance updates or to reinstall DSNlink for any other reason.

Intended Audience
The audience for this document is the system administrator who installs DSNlink
software.

Structure of this Document
This document is organized as follows:

• Chapter 1, Preparing to Install DSNlink, describes the operating system,
related software, and hardware requirements for DSNlink installation and
the related procedures you complete before the installation.

• Chapter 2, Installing DSNlink on a Tru64 UNIX System, shows a sample
installation.

• Chapter 3, Postinstallation Tasks, describes the postinstallation procedures
you must complete.

• Appendix A, Dialer Driver Script Facility Commands, is a list of the
commands you can enter in modem dialer scripts.

• Appendix B, DSNlink Directories on Your System, describes the hierarchy
and contents of DSNlink Version 3.0 directories.

For a list of the documentation, see Chapter 3.
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Conventions Used in This Document
This document uses the conventions listed in Table 1, as needed:

Table 1 Manual Conventions

Convention Description

boldface text Boldface text is used in examples to show what the user types to
contrast that with the results of the command.

monospace
type

Monospace type designates commands and examples.

.

.

.

A vertical ellipsis indicates the example continues, but the additional
text is not displayed.

vi



1
Preparing to Install DSNlink

This chapter contains information you need to know or verify before installing
DSNlink.

1.1 Overview of the Installation Process
The DSNlink installation procedure uses setld. It does not require shutting down
your system.

Restrictions
These restrictions apply to the DSNlink installation:

• You cannot have DSNlink Version 3.0 and any previous versions of DSNlink
on the same system. If there is a previous version of DSNlink on the system,
you must delete it before installing DSNlink Version 3.0. See Section 1.11.

Recommendations
Compaq recommends that you back up your system before installing any
software. For details on performing a system backup, see your Tru64 UNIX
documentation.

Install DSNlink on a gateway node first. A gateway node is one that has a direct
connection to Compaq. After installing on a gateway, you can install DSNlink on
systems that connect to the gateway.

Note that if your site has multiple DSNlink nodes, you do not have to upgrade
to DSNlink Version 3.0 on all nodes. It is compatible with previous versions of
DSNlink.

What the Installation Procedure Does
The DSNlink installation procedure does the following:

1. Presents an Electronic Service Tools agreement. If you agree to the terms, the
installation procedure continues. To preview the agreement, see the sample
installation script in Chapter 2.

2. Checks for the supported versions of Tru64 UNIX, which are Versions 4.0d,
4.0e, 4.0f, 5.0, 5.0a, and 5.1.

3. Verifies that you have sufficient disk space for DSNlink.

4. Checks for previously installed versions of DSNlink

5. Prompts you for a unique group for the DSNlink executables and files

For more information, see Section 1.8.3.

6. Sets the group ownership of the files or directories to the group you created

Preparing to Install DSNlink 1–1
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7. Prompts you for your access number or numbers, the node’s name, your
Customer Support Center, which transports you want to use with DSNlink,
the name of a person to contact if Compaq must reach you by telephone, and
your authentication key

8. Adds entries to /etc/services and /etc/inetd.conf for communications with the
DSNlink host system, if you agree to the additions

9. Prompts you for information necessary to configure each of the transports

For more information, see Section 1.10.2.1.

10. Runs the DSNlink Network Exerciser to test the connection to the host
system

1.2 What You Need from Compaq
If your site has no earlier versions of DSNlink, you need an authorization letter
from Compaq before installing DSNlink. The letter contains the following items:

• Your access number. Instead of an access number, your letter may have a
contract number or serial number.

• Your authentication key

• The location of your Customer Support Center.

The installation procedure prompts you for the previous items.

If you have previous versions of DSNlink, you do not need an authorization letter.
You can use the same access number and Customer Support Center.

Note

It is extremely important to keep your authentication key secret. Anyone
who has your access number, authentication key, and DSNlink has access
to your DSNlink account.

1.3 Release Notes
DSNlink provides online release notes only. Compaq recommends you read the
release notes before using the product.

For the location of the release notes and other online documents, see Section 3.2.

1.4 Checking the Software Distribution Kit
If you order a DSNlink kit from Compaq, the DSNlink Version 3.0 for Tru64
UNIX kit contains a CD—ROM optical disk for Alpha systems. The kit also
includes the following additional items:

• The cover letter

• A Read This First page that explains how to begin

All other documents are on line.
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1.5 How to Get DSNlink Version 3.0
The DSNlink Version 3.0 kit is available from the following sources:

• The DSNlink Web site:

http://www.support.compaq.com/dsnlink/kit_unix_v30.htm

Click on the link to the page for DSNlink Version 3.0.

• An FTP directory:

ftp.support.compaq.com

Set default to the directory public/DSNlink/unix.

The Readme on the Web site explains how to copy the kit from both the Web
site and FTP directory.

1.6 Using RIS for Client Installations
You can install DSNlink on a Remote Installation Services (RIS) server area and
then use RIS to install DSNlink on local systems. In this case, you need to do the
following:

1. Use the ris utility to install the DSNlink subsets from the distribution media
into the RIS server area.

2. Make the DSNlink subsets available on line so that subsequent installations
of DSNlink can use RIS.

3. Make sure the local system is registered as a RIS client.

4. Provide the name of the server system to the local node for the installation
procedure.

1.7 Installing DSNlink on Clusters
You can install DSNlink on a cluster running Tru64 UNIX Version 5.0a or 5.1
with these restrictions:

• You can use only the TCP/IP transport. Modems, X2.5, and DECnet™ are not
supported.

• You must supply the cluster alias name when the prompt for the DSNlink
node name appears in the installation procedure.

• The installation, which you perform once, makes all nodes in the cluster
either A nodes or B nodes, depending on which node type you specify during
the installation.

The configuration portion of the installation may occur multiple times, for
example, three times on a two-node cluster. This does not create any problems or
require follow up actions.

1.8 Preinstallation Requirements
This section lists the preinstallation requirements for DSNlink and how to verify
that your system meets those requirements. The following checklist is a summary
of the requirements. Before you install DSNlink, be sure to do the following:

Be able to log in to the target node as root.

Create the group for DSNlink files. See Section 1.8.3.
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If you installed a previous version of DSNlink, you do not have to create a
new group. The DSNlink Version 3.0 installation presents the previous group
for your confirmation.

Check the hardware requirements. See Section 1.8.5.

Check the software requirements. See Section 1.8.6.

Determine which subsets to install. See Section 1.8.7

Determine if there is sufficient disk space. See Section 1.8.8.

Determine which transport or transports you will use to connect your
DSNlink node to Compaq. See Section 1.10.

Set up the DECserver, if you have one, for use with DSNlink. See
Section 1.10.2.

Deinstall previous DSNlink kits. See Section 1.11.

Back up the system.

1.8.1 Time Required
A local installation takes approximately 5 to 15 minutes. An RIS client
installation may take longer because it is dependent on network activity at
the time of the installation. If the network is not active, you should expect an
installation time roughly equal to a local installation.

1.8.2 Have Root Login Privileges
You must be able to log in as root where you are installing DSNlink. Only when
you are logged in as root do you have the required permissions to install the
DSNlink software.

1.8.3 Create a Group for the DSNlink Files
Before you install DSNlink, you must create a group for the DSNlink executables.
To prevent possible security breaches, Compaq recommends that you create a
unique, new group. Do not use general user groups such as users, guest, or
staff. Use of a group such as system, kmem, operator, or daemon can create a
serious security problem. You can name the group dsnlink.

If your system had DSNlink installed previously, you can use the group name
used by the last DSNlink kit.

Make sure no one is a member of the group. Its purpose is to run DSNlink. If
there are members, potential security breaches could occur because members
could read files that are otherwise readable only by the superuser and DSNlink
software.

For information on creating groups, see the addgroup (8) reference page. If
you use BIND, refer to the network setup manual. If you use Hesiod or NIS to
maintain groups, see the operating system’s documentation for instructions.

1.8.4 BIND Recommendations
Compaq recommends that you run a naming service such as BIND rather
than entering a host name manually in /etc/hosts. See the appropriate
documentation for information.
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1.8.5 Hardware Requirements
Hardware Required for Installation
You must install DSNlink on an Alpha system. You also need a CD—ROM reader
if you install DSNlink from CD—ROM.

Modem Hardware
If you use the modem transport for DSNlink communications, you must have
a modem dedicated to DSNlink. A dedicated modem permits the immediate
handling of both incoming and outgoing communications. Compaq uses the
incoming mode to respond to your service requests and make other connections as
you authorize.

Although DSNlink provides dialer scripts for several types of modems, you do
not have to use one of those modems. If you use a modem for which there is no
dialer script, you must create a script for the modem. For more information, see
Section 3.9.

You must also have an asynchronous serial port on your system or DECserver.

1.8.6 Software Requirements
DSNlink Version 3.0 requires the following software:

• Tru64 UNIX Version 4.0d, 4.0e, 4.0f, 5.0, 5.0a, and 5.1.

• The DEC OSF/1 Base System subset (OSFBASE) must be loaded on the
system where you install DSNlink.

To verify that the subset is loaded, do the following:

1. Log in to the system where you will install DSNlink.

2. Enter the following command to verify that the OSFBASE subset is
installed. This example shows the command and the response when the
subset for Tru64 UNIX Version 5.0 is installed:

% /usr/sbin/setld -i | grep OSFBASE
OSFBASE500 installed Base System (- Required -)

If the word installed is missing or there is no response, the subset is not
loaded. For information on how to load the operating system software, see
the Tru64 UNIX documentation.

• The appropriate network software for the network transport you choose:

• X.25 for Tru64 UNIX—the version required for your operating system and
the corresponding Compaq software

• DECnet/OSI for Tru64 UNIX—the version required for your operating
system and the corresponding Compaq software

• TCP/IP—Tru64 UNIX includes this transport; no additional software is
required

• Modem—does not require operating system software

Preparing to Install DSNlink 1–5



Preparing to Install DSNlink
1.8 Preinstallation Requirements

1.8.7 Determining Which Subsets to Load
DSNlink has these subsets:

• DSNALIB300–with the description "DSNlink V3.0 Communications Library"

This is a required subset.

• DSNALIBNE300–with the description "DSNlink NE V3.0 Communications

If you install the kit without encryption, this subset is required.

• DSNABASE300—with the description "DSNlink V3.0 Customer"

This is a required subset.

• DSNALANG300—with the description "DSNlink V3.0 International Language
Support"

This subset contains translated files for Japanese and French.
Other languages may be added in the future. Contact your local
Compaq representative to determine if other languages are supported.
DSNALANG300 requires the WWBASE subset.

• DSNADOC300—with the description "DSNlink V3.0 On-line Documentation"

Load this subset to make the online documentation accessible to DSNlink.
Note that all user documentation is on line.

The DSNlink reference pages are in a separate subset.

• DSNAMAN300—with the description "DSNlink V3.0 Reference Pages"

Load this file to have the DSNlink reference pages.

1.8.8 Determining Disk Space Requirements
The disk space requirements apply to the disks where you load the DSNlink
subsets for RIS and local installations.

Note

If you have a previous version of DSNlink on your system, you must
deinstall it before installing DSNlink Version 3.0. If the previous subsets
remain in place, the installation fails.

Table 1–1 lists the disk space requirements for loading DSNlink software
subsets.

Table 1–1 DSNlink Kit Size

Kit Size
Size After
Installation /usr /var

20.5 MB 22.0 MB 21.0 MB 1.0 MB

To determine if your system has enough disk space, use the df command. The
following example shows the total space and free space in the /var/opt directory
on a Tru64 UNIX system:

# df -k
Filesystem 1024-blocks Used Available Capacity Mounted on
/dev/rz10d 534210 98462 382326 20% /var
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1.9 Configuring Nodes
If you have no previous versions of DSNlink, you need to decide which nodes
at your site you want to connect directly to Compaq. DSNlink refers to those
as Node A systems. All communications between your systems and Compaq
originate on or pass through the A nodes. All other DSNlink nodes, called B
nodes, connect to an A node. The installation procedure asks whether you are
installing DSNlink on an A node or a B node. If the answer is a B node, the
installation prompts you for the name of the A node. Therefore, before you install
DSNlink decide:

• Which systems will be A nodes

• Which systems will be B nodes

• Which transports you want to use between the A nodes and Compaq

• Which transports to use between the A and B nodes

If you have previous versions of DSNlink, you do not have to upgrade them to
DSNlink Version 3.0.

1.9.1 Using WorldWire and DSNlink as A and B Nodes
If you have a product that uses Compaq’s WorldWire software, for example
Compaq Remote Support Service (CRSS), you can set up DSNlink to use a
WorldWire node A or allow the DSNlink node A system to accept connections
from WorldWire node B systems. The node A systems (called front-end nodes in
WorldWire), are the gateways that make connections to Compaq. Node B systems
(referred to as back-end nodes in WorldWire), connect to the Node A systems.

Configuring a DSNlink B Node to Use a WorldWire A Node
To make a DSNlink B node use a WorldWire A node:

1. During the DSNlink installation, when the prompt appears for the node type,
enter that the node is a B node. For example:

+------+ [1] +------+ [2] +--------+
|NODE_B|----- TCP/IP, ----->|NODE_A|----- TCP/IP, ---->| Compaq |
+------+ DECnet, +------+ DECnet, +--------+

or X.25 (DSNlink X.25, or
Gateway) Modem

Is wynken like NODE_A, NODE_B, or NODE_C in the above diagrams? [A]: B

2. When prompted for the transports to use between the A and B nodes, enter
TCP/IP. (TCP/IP must be the only selected transport for this node.)

3. When prompted for the name of the Node A, enter the IP name or address of
the WorldWire node as the fully-qualified IP host name.

4. Continue with the rest of the installation.

Configuring a WorldWire B Node to Use a DSNlink A Node
You can route WorldWire Versions 2.7 and 2.8 connections through DSNlink A
nodes. The WorldWire and DSNlink systems may connect to different service
providers and use different access numbers (referred to as service IDs in
WorldWire).
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To set up a DSNlink Node A to process connections from Node B systems with
WorldWire:

1. During the DSNlink installation, when the prompt appears for the node type,
enter that the node is an A node. For example:

+------+ [1] +------+ [2] +--------+
|NODE_B|----- TCP/IP, ----->|NODE_A|----- TCP/IP, ---->| Compaq |
+------+ DECnet, +------+ DECnet, +--------+

or X.25 (DSNlink X.25, or
Gateway) Modem

Is wynken like NODE_A, NODE_B, or NODE_C in the above diagrams? [A]: Return

2. When prompted for the transports to use between the A and B nodes, enter
TCP/IP. (TCP/IP must be the only selected transport for this node.)

3. Complete the installation

After the installation is complete:

1. Using dsnmapq, determine if an entry already exists in your route map for a
connection to a WorldWire service provider.

You do that by finding the welcome letter from the product that uses DSNlink
and seeing if the Service Provider ID exists in the route map. In this example,
compaq is the service provider and the portal is crgcxo:

% dsnmapq compaq/crgcxo

2. If no previous entry exists, add an entry for the WorldWire service provider.
Use this format:

SPID/SPP t/sp_ip_address/2370

where:

• SPID is the Service Provider ID specified in your WorldWire welcome
letter

• SPP is the Service Provider Portal specified in your welcome letter

• sp_ip_address is the Service Provider’s IP Address

• specified in your welcome letter

• 2370 is the port number for dsn_nsd

For example:

% dsnmapq -a "compaq/crgcxo t/dsn.service.compaq.com/2370"

3. On the WorldWire node, attempt a connection to the service provider to
ensure that the route map entry is correct.

1.10 Preinstallation Information for the Network Transports
You can use any of the following network transports to connect your DSNlink
node to Compaq:

• DECnet

• TCP/IP

• X.25

• Modem, which supports IDSN and PSTN line types
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If you have more than one of the above network protocols, you can specify which
ones to configure for use by DSNlink. For example, if your system has all the
transports, you can configure them all or specify just the ones you want to use.
DSNlink assigns each a cost factor. When making connections, DSNlink uses the
one with the lowest cost factor.

You can add or remove transports after the installation using the DSNlink Setup
utility.

1.10.1 TCP/IP Ports
If using the TCP/IP transport, DSNlink applications assign the ports shown in
Table 1–2.

Table 1–2 Ports Used by DSNlink Applications

Application
Abbreviation Port Application Name

dsn_nsd 2370 Name server daemon

dsn_mail 2372 DSNlink Mail

dsn_its 2373 Interactive Text Search

dsn_login 2374 Remote Login

dsn_netex 2375 Network Exerciser

dsn_sra 2376 Service Request application

dsn_k2 2377 Cryptographic Services

dsn_file 2379 File Copy

dsn_osha 2380 Obligation and Service History application

The port entries must be added to the file /etc/services. During the
installation, you can choose to have the installation procedure add the entries to
/etc/services for you.

NOTE: You can configure a single port. For more information, see the ITS article,
"V2.x How to Configure for 1 Firewall Port" in the DSNlink database.

1.10.2 Settings for DECservers
DSNlink supports the DECserver 700/MC and DECserver 200. Note that
the maximum speed of a DECserver 200 is 19200 baud. If you use it, expect
performance problems.

To see the current settings for a terminal server port, log in to the DECserver,
enable privileges, and enter the LIST PORT n command (where n) is the terminal
server port number where the DSNlink modems are to be attached).

Recommended DECserver parameters are shown in the following example:

Local> LIST PORT n

Port n:

Character Size: 8 Input Speed: 9600 1
Flow Control: CTS 2 Output Speed: 9600
Parity: None Modem Control: Enabled

Access: Remote Local Switch: None
Backwards Switch: None Name: DSN_MODEM_nnn 3
Break: Local Session Limit: 1
Forwards Switch: None Type: Soft
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Preferred Service: None

Authorized Groups: 0
(Current) Groups: 0

Enabled Characteristics: 4

Dialup, DTRwait, Input Flow Control, Output Flow Control,

1 This number must match the DTE speed of the modem.

You can enter any speed your modem can achieve.

2 CTS flow control is recommended. XON flow control may result in errors.

3 Be sure the port name is unique.

4 Disable the Remote Modification characteristic.

Note: When Remote Modification is enabled on the terminal server port, it
accepts the modem speed from the modem device definitions file until the
speed setting is greater than 38400. Above 38400 bps, the terminal server
port ignores the speed setting in the modem device definitions file and uses
9600 baud instead. Disabling Remote Modification on the terminal server
port and setting it to a port speed greater than 38400 corrects the problem.

1.10.2.1 Make Notes for Installation Questions
Make notes about the following items, which you need for the modem transport
installation questions:

The line type, which can be either PSTN or ISDN.

The DTE speed, which is set by the modem manufacturer. If you use an LTA
device, the DTE speed also appears in the port specification.

The modem’s phone number, including any prefixes for local and long distance
calls.

For DECservers:

• A LAT number, which you can choose during the installation. You enter
this device for the prompt for the ISDN or PSTN modem device name.

• The server name. You enter the name at the prompt for the LAT terminal
server name.

• The port name. You enter the name at the prompt for the LAT terminal
server’s port name.

1.10.3 Modem Dialer Scripts
If you want to use the modem transport, you must have a dialer script for your
modem. DSNlink includes dialer scripts for several modems. If yours is not in
the list, you can modify one of the provided scripts.

For information on modem scripts, see Section 3.9.

1.11 Deinstalling DSNlink Kits
The DSNlink installation stops if any of these versions of DSNlink are installed
on your system:

• DSNlink Version 2.0

• DSNlink Version 2.1

• DSNlink Version 2.1A
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• DSNlink Version 2.3

• DSNlink Version 2.3E

• DSNlink Version 3.0

Therefore, you must use the following procedure to deinstall the kits before
proceeding with the next DSNlink installation. Note that the deinstallation
process does not delete customizable files. For a list of the files that are NOT
deleted, see Table 1–3.

To determine if any previous savesets are on the system, use this command:

% ls /usr/var/opt/DSNA*

To remove existing DSNlink subsets and the directory paths for them:

1. Log in as root to the system containing the subsets to remove.

2. The following commands deinstall different versions of DSNlink. Enter the
one that applies to the version of DSNlink you want to deinstall:

• For DSNlink Version 2.0 for Tru64 UNIX, use this command to remove
the base and documentation subsets:

# setld -d DSNABASE200 DSNADOC200

• For DSNlink Version 2.1, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE210 DSNADOC210 DSNALANG210 DSNAMAN210

• For DSNlink Version 2.1A, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE211 DSNADOC211 DSNALANG211 DSNAMAN211

• For DSNlink Version 2.3, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE230 DSNADOC230 DSNALANG230 DSNAMAN230

• For DSNlink Version 2.3E, use this command to remove the base,
documentation, language, and reference pages subsets:

# setld -d DSNABASE235 DSNADOC235 DSNALANG235 DSNAMAN235

• For DSNlink Version 3.0, use this command to remove the library, base,
documentation, language, and reference pages subsets:

# setld -d DSNALIB300 DSNABASE300 DSNADOC300 DSNALANG300 DSNAMAN300

If you have the nonencrypted version of DSNlink, you need to remove the
following subsets:

# setld -d DSNALIBNE300 DSNABASE300 DSNADOC300 DSNALANG300 DSNAMAN300

The deinstallation procedure asks if you want the installation procedure
to automatically modify the file /etc/services and /etc/inetd.conf. If you
answer yes, the deinstallation procedure removes entries for DSNlink
from those files.

Note that the DSNlink Version 3.0 deinstallation process does not
correctly delete the X.25 entities. For information on how to delete them,
see the DSNlink Version 3.0 for Tru64 UNIX Release Notes.
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3. If you do not want to reinstall DSNlink, also delete the files listed in the
Table 1–3.

Do not delete other directories left behind if you are reinstalling DSNlink.

The deinstallation procedure does not delete all DSNlink files and directories.
Therefore, if you do not want to reinstall DSNlink, you should delete the files and
directories shown in Table 1–3. They are all rooted at /var/opt/DSNA300.

Table 1–3 Files Not Deleted by a Deinstallation

Directory Contents Description of the Files

config routemap The route map for making connections
between your system and Compaq

config dsn_local_auth.dat
dsn_remote_auth.dat

The file that permits local users access to
DSNlink
The file that allows Compaq access to your
DSNlink applications

config .dsnrc The configuration file

config dsn_sra_signature.txt A signature file that is automatically
appended to service requests

keys MD5-DIGITAL-access_
number

Your authentication keys

logs dsn_history.log and
application log files

Log files that record DSNlink usage

public /incoming and /outgoing Directories for files copied to and from
your system using the DSNlink File Copy
application

Note: The /outgoing files directory is not
used. Specialists cannot use the DSNlink
File Copy application to copy files from
your system even if they are placed in that
directory.

Note that the online documentation is in the /usr/lib/dsn/help directory. If you
customized any documentation files you want to keep, you should rename or move
them before installing DSNlink Version 3.0.

Note

The deinstallation procedure removes the modem scripts in /usr/lib/dsn
/modem. If you modified scripts from previous DSNlink installations and
want to keep them, rename or move them before reinstalling DSNlink.
DSNlink Version 2.0 scripts are obsolete.

1.11.1 Deleting the X.25 NCL Configuration
When deleting old DSNlink base subsets with setld, you can choose to delete the
X.25 entities or modify them afterwards.

Note that deleting the entities disconnects any currently established X.25
connections.
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1.12 Backing Up Your System
Compaq recommends that you back up your system before installing any
software. For details on performing a system backup, see your Tru64 UNIX
documentation.

1.13 Stopping the Installation
You can stop the installation procedure any time by entering Ctrl+C. However,
files created up to this point are not deleted automatically. You must delete these
files. Appendix B lists the directories created during the installation procedure.

1.14 Error Recovery
If errors occur during the installation, the system displays failure messages. If
the installation fails due to insufficient disk space, the installation procedure
displays a message indicating that there is not enough file system space for the
subset and that it will not be loaded.

Errors can occur during the installation if any of the following conditions exist:

• The operating system version is not supported.

• The prerequisite software is not installed, or its version is not supported.

• DSNlink has already been installed.

• The target architecture is not Alpha.
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Installing DSNlink on a Tru64 UNIX System

This chapter provides a sample installation for DSNlink Version 3.0.

Before starting the installation, read Chapter 1, which describes options and
requirements for installing the product.

For information about the DSNlink documents you can print or display before
you install DSNlink, see Section 3.2.

Warning

DECnet/OSI for DIGITAL UNIX may hang the installation. We
recommend shutting down DECnet during the installation using this
command:

# /usr/sbin/decnetshutdown

You can restart DECnet with this command:

# /usr/sbin/decnetstartup

2.1 Installing the tar File
Start the installation procedure as follows:

1. Log in as superuser (login name root) where you are installing DSNlink.

2. Create a scratch directory for extracting the tar file’s contents. For example:

# mkdir /usr/scratch

3. Set default to the scratch directory:

# cd /usr/scratch

4. Extract the contents of the tar file:

# tar xvf /tar-directory/DSNA300.tar

5. Begin the installation with a setld command that specifies the load function
(-l) and identifies the directory where the DSNlink subsets are located. For
example:

# setld -l /usr/scratch/dsna300/kit
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2.2 Sample Installation
The following installation procedure configures all transports, TCP/IP, DECnet,
X.25, and modem. Your installation will vary from this script depending on your
choices of subsets and transports and whether a previous version of DSNlink was
installed. If you deinstalled previous versions of DSNlink for Tru64 UNIX, some
files remain which this installation procedure renames and saves.

The installation script uses the following sample entries, which you change to the
names your system uses:

• The installer created the group dsn before starting the installation.

• DSNlink is installed on a node named Wynken.

• The sample access number is 1234567.

• Default values appear within square brackets ([ ]). You can accept the default
value by pressing the Return key. Or, you can override the default by entering
the value you want. Boldface text shows examples of entries that replace the
default values.

At the end of the sample installation are descriptions of each callout number.

----------------------------------------------------------------------------

# setld -l /usr/scratch/dsna300/kit 1

*** Enter subset selections ***

The following subsets are mandatory and will be installed automatically
unless you choose to exit without installing any subsets:

* DSNlink V3.0 Communications Library 2
* DSNlink V3.0 Customer

The subsets listed below are optional:

There may be more optional subsets than can be presented on a single
screen. If this is the case, you can choose subsets screen by screen
or all at once on the last screen. All of the choices you make will
be collected for your confirmation before any subsets are installed.

- Other:
1) DSNlink V3.0 International Language Support 3
2) DSNlink V3.0 On-line Documentation
3) DSNlink V3.0 Reference Pages

Or you may choose one of the following options:

4) ALL mandatory and all optional subsets
5) MANDATORY subsets only
6) CANCEL selections and redisplay menus
7) EXIT without installing any subsets

Estimated free diskspace(MB) in root:32.4 usr:265.4 var:354.4 i18n:413.3 4

Enter your choices or press RETURN to redisplay menus.

Choices (for example, 1 2 4-6): 4 5

You are installing the following mandatory subsets:

DSNlink V3.0 Communications Library
DSNlink V3.0 Customer

You are installing the following optional subsets:
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- Other:
DSNlink V3.0 International Language Support
DSNlink V3.0 On-line Documentation
DSNlink V3.0 Reference Pages

Estimated free diskspace(MB) in root:32.4 usr:261.5 var:354.4 i18n:413.3

Is this correct? (y/n): y

Checking file system space required to install selected subsets:

File system space checked OK.

5 subset(s) will be installed.

Loading 1 of 5 subset(s)....

DSNlink V3.0 Communications Library
Copying from /usr/scratch/dsna300/kit (disk)
Verifying

Loading 2 of 5 subset(s)....

Copyright 1995, 2000 by Compaq Computer Corporation

Confidential computer software. Valid license from Compaq
required for possession, use or copying. Consistent with FAR
12.211 and 12.212, Commercial Computer Software, Computer
Software Documentation, and Technical Data for Commercial
Items are licensed to the U.S. Government under vendor’s
standard commercial license.

This services tool software is the property of, and contains
confidential technology of, Compaq. Possession and use of
this software is authorized only pursuant to the Proprietary
Service Tool Software License contained in the software or
documentation accompanying this software.

Compaq and the Compaq logo Registered in U.S. Patent and
Trademark Office.

Motif is a trademark of The Open Group.

All other product names mentioned herein may be trademarks or
registered trademarks of their respective companies.

The RSA BSAFE Crypto-C software contained in this product is
licensed from RSA Security Inc.

This product includes software developed by the University of
California, Berkeley and its contributors.

Copyright (c) 1983, 1986, 1987, 1988, 1993
The Regents of the University of California.
All rights reserved.

Press Return or Enter to continue: 6

You can stop the installation procedure at any time by pressing
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• U.S. Robotics modems

If you have another modem, you must create a script for it. To create a modem
script:

1. If possible, choose an existing script to modify. The scripts are in the directory
/usr/lib/dsn/modem/ with these file names:

• co2264.ddsf_src — the Codex 2264 script for XON/XOFF flow control

• co2264hw.ddsf_src — the Codex 2264 script for RTS/CTS hardware flow
control

• df196.ddsf_src — for Digital DF196 modems

• df296.ddsf_src — for Digital DF296 modems

• hayes.ddsf_src — for Hayes™ modems, XON/XOFF flow control

• hayeshw.ddsf_src — for Hayes™ modems, RTS/CTS hardware flow
control

• multimodem.ddsf_src — for Multi-Tech® modems XON/XOFF software
flow control

• multimodemhw.ddsf_src — for RTS/CTS hardware flow control for
Multi-Tech modems multimodem_eu.ddsf_src — for European Multi-Tech
modems XON/XOFF software flow control multimodemhw_eu.ddsf_src —
for European Multi-Tech modems RTS/CTS hardware flow control

• null.ddsf_src — a script to aid in troubleshooting modem problems

• repko_eu.ddsf_src — for European REPKO modems with XON/XOFF
flow control

• repkohw_eu.ddsf_src—for the European REPKO modems with RTS/CTS
flow control

• usrobotics.ddsf_src for U.S. Robotics® modems XON/XOFF software
flow control

• usrobotics.ddsf_src for U.S. Robotics RTS/CTS hardware flow control

Modem scripts may be updated in the future. For the current modem scripts,
see the following Compaq Web site:

http://www.support.compaq.com/dsnlink/modem_scripts.htm

2. If you want to create a new script, use the existing scripts as a guide to the
sequence and contents of the script commands. For a list of commands, see
Appendix A.

3. See Section 3.9.1 for guidelines on modifying or creating scripts.

4. Copy your script to: /usr/lib/dsn/modem/

Be sure the file name has the format modem-name.ddsf_src, for example,
ourmodem.ddsf_src. The name must be in lowercase.

5. If you modify a dialer script supplied in the kit, rename it. This prevents its
being overwritten if you reinstall DSNlink later. A reinstallation replaces the
original scripts with new ones but does not delete unrecognized scripts.

For example, if you modify the co2264.ddsf_src script, your modified script
name could be co2264new.ddsf_src.
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6. Test the script using the dsnmmgr test script command. The following
command tests the script ourmodem.ddsf_src (note that the file extension is
not included) at the baud rate 14400, and a dialed network address (dna) as
shown:

# dsnmmgr test script \
-device /dev/tty02 \
-script ourmodem \
-speed 14400 \
-dna m/pstn.719-555-5555/dsn_nsd

For more information, see the dsnmmgr(8) reference page.

7. If you copied a new script to the /usr/lib/dsn/modem directory, you must
make it available to DSNlink. Start the DSNlink Setup utility as explained
in Section 3.8. Use menu item m, Change the Modem Configuration, and go
to the prompt for your modem script. Choose the script you created from the
list of modem scripts.

8. Run the installation verification procedure from the DSNlink Setup utility,
menu item v or run the Network Exerciser utility.

3.9.1 Guidelines for Scripts
The following are guidelines and suggestions for modifying and creating modem
dialer scripts:

• Modify an existing script if possible. Use a script whose control commands
are most like your modem’s commands. For example, if your modem uses
Hayes compatible commands, make a copy of the hayes.ddsf_src script and
modify it.

• For descriptions of the commands in the dialer scripts, see Appendix A.

• Make sure the modem’s description is on the same line as the Description:
label in the script. The DSNlink Setup utility and the installation process
display the description when listing the modem scripts. The following
example shows the correct placement:

!* Module Name:
!*
!* ourmodem.DDSF_SRC
!*
!* Description: Script for our modem
!*

• Use verbose mode rather than numeric mode for returns. The following
example uses the verbose "CONNECT 14400" instead of the numeric FIND
"13":

FIND "CONNECT 14400"
IF FOUND RETURN CONNECT SPEED 144000

This example shows the verbose "NO CARRIER" instead of the numeric "3".

FIND "NO CARRIER"
IF FOUND RETURN NO_ANSWER PROTOCOL "No carrier detected"

• Disable the +++ escape sequence, if your modem uses it.

Most modems have an escape sequence that switches the modem from
communicating mode back to command mode. On a Hayes modem, it is the
sequence +++. Disabling the escape sequence prevents a disconnection if data
sent by DSNlink includes the escape sequence.
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• Consider disabling a call waiting line, if you have one, to prevent an incoming
call from interrupting the DSNlink modem connection. You can include the
command in the dialer script.

For example, a *70 at the start of the dial string disables call waiting, and the
comma creates a pause for a few seconds before processing the next command:

SEND "ATDT*70,"

• Set the modem’s DTE (Data Terminating Equipment) flow control between
the modem and your computer or terminal server to RTS/CTS if you use a
DECserver. The DSNlink software protects the dc1 and dc3 characters in
data transmission so they are not interpreted as flow control.

Do not use "XON/XOFF Passthru" mode or DTR/DTS flow control.

• Use 8-bit characters. The 7-bit data transfer is not supported.

• Many modems provide a feature whereby an incoming call to the modem
causes announcement and attachment messages, such as "Ring Detected" and
"Attached: xxxx baud."

Disable these messages for incoming calls. This prevents their being
interpreted as data, which must then be discarded.

• Note that several DSNlink applications create incoming calls to your modem,
such as DSNlink Mail, the Service Request application, and Remote Login.
Therefore, you should not disable incoming calls.

• The modem should be configured so that when a dialed connection loses the
carrier (when the remote system hangs up or the line drops), the modem
lowers its DCD1 signal. This allows the operating system to signal a "carrier
lost" event to the DSNlink software.

Typically, this is achieved by:

Enabling Modem Control on the terminal server port or by using the
hupctl characteristic on the /dev/tty or /dev/lat/nnn device

If the modem understands Hayes commands, set up the &C1
characteristic in the modem’s permanent memory (AT&C1&W0).

• The modem should be configured so that if your local system terminates the
connection by lowering its DTR2 signal, the modem responds by hanging up
and resetting itself.

Typically, this is achieved by:

Enabling Modem Control on the terminal server port, using the hupctl
characteristic on the /dev/tty or /dev/lat/nnn device, or by setting the
Modem characteristic on the TXAn: or TTAn: device.

If the modem understands Hayes commands, use the &D2 command.
Compaq recommends you do this in permanent memory on the modem
(AT&D2&W0) and NOT in your dialer script because just issuing the
command can cause a modem to reset and disconnect.

1 The Data Carrier Detect (DCD) signal is transmitted by the modem and read by the
computer or terminal server on pin 8.

2 The Data Terminal Ready (DTR) signal is transmitted by your computer or terminal
server and read by your modem on pin 20 of an EIA RS-232 connector.
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• If your modem is connected to a LAT terminal server, such as a DECserver,
the terminal server port should disallow the Remote Modification feature.
This feature permits the host computer system to change the baud rate,
character length, and parity settings of the terminal server port. The
terminal server should not permit those modifications.

• If your modem has a speed buffering capability (most do), enable it. This
feature allows the modem to communicate with your computer at a fixed
speed regardless of the phone line connection speed. Use the highest DTE
speed supported by both your modem and your DTE device (computer or
terminal server port).

• For maximum throughput, use RTS/CTS hardware flow control on modem
speeds greater than 9600 baud.

3.10 Log Files
DSNlink creates several types of log files in the directory /usr/lib/dsn/logs.
You can archive or delete the files as desired.

• The history log file, dsn_history.log

This file contains records for each use of DSNlink applications. DSNlink
continues to write to this file indefinitely. Therefore, if the file gets too large,
you can create a new one and archive or delete the old log file.

• Server log files, which have the format
dsn_application_yydddhhmmss_pid.log

When Compaq connects to your system, DSNlink creates these log files.

• Records of remote login sessions, such as:

dsn_login_95006160902_23341.log and
dsn_login_95006160902_23341.log_session.

• Modem daemon run logs, which have the format
dsn_run_linetype_linename.log

These files list the modem daemon’s activities.

For more information, see section 8.4, Using the History Records and Other Log
Files, in the DSNlink User’s Guide. See also the reference page dsn_netd.sh.

3.11 Changing a Multiple-Port Firewall to Single-Port
If you used previous versions of DSNlink, your firewall may be set up to use
multiple ports for DSNlink applications. If so, you can remove all the ports
except port 2370, which is used in DSNlink Version 3.0 for all applications. These
are the ports previously used by DSNlink applications that you can remove:

Port Abbreviation Application

2372 dsn_mail DSNlink Mail

2373 dsn_its Interactive Text Search

2374 dsn_login Remote Login

2375 dsn_netex Network Exerciser

2376 dsn_sra Service Request Application
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Port Abbreviation Application

2377 dsn_k2 Cryptographic Services

2379 dsn_file File Copy

3.12 Learning to Use DSNlink
Getting Help While Using DSNlink
To get help while you are using DSNlink in the DECwindows Motif interface:

• In a window, pull down the Help menu. Choose Help => Tutorial if you
want a brief set of instructions for using the application. Choose Help => On
Window if you want reference help on fields and items in the window.

• In a dialog box, click on Help.

• To get help on an error message, choose Help => Error Messages from the
DSNlink main window. Choose the Mosaic window’s File => Find in Current...
to display a dialog box that allows you to enter a search string.

• To see the DSNlink glossary, choose Help => Glossary from the DSNlink main
window.

• To dismiss the online help windows, choose File => Exit Program from the
Mosaic window.

Getting Help on the Command Line Interface
To learn how to use DSNlink in the command line interface, enter the dsnhelp
command:

% dsnhelp

DSNlink displays a list of hypertext links. Choose the one that interests you.

Displaying the DSNlink User’s Guide

1. Start DSNlink with the dxdsn command:

% dxdsn

The DSNlink main window appears.

2. From the Help menu, choose User’s Guide.

DSNlink displays the Table of Contents and Preface for the DSNlink User’s
Guide using the Mosaic browser.

3. Click on the topic you want.
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Dialer Driver Script Facility Commands

A.1 Description
This appendix lists the commands in modem dialer scripts. The information is
intended for reference when you create a new dialer script or modify an existing
one.

The modem script language, Dialer Driver Script Facility (DDSF), must be used
to create the modem scripts for use by DSNlink applications. The purpose of a
modem script is to automate the process of dialing the phone number for the
DSNlink host and establishing a connection. If the connection is not established,
the script’s error handling procedures notify the user of the reason for the
connection failure.

Modem Scripts
The DSNlink modem dialer scripts are in:

/usr/lib/dsn/modem/

The scripts have the file extension .ddsf_src.

Any dialer script you create or modify must be in this directory and have the file
extension .ddsf_src to be accessible to DSNlink.

For More Information
For information on modifying dialer scripts, see Section 3.9.

A.2 Delimiters
Table A–1 describes the valid DDSF command language delimiters.

Table A–1 Supported DDSF Command Language Delimiters

Space or Tab All commands and keywords must be separated by at
least one space or tab character.

Quotation marks All text strings used in the commands must be enclosed
in quotation marks (" ").

Exclamation point An exclamation point (!) in the script file tells the DDSF
processor that any text from that point to the end of that
line is a comment and should be ignored. Do not use
comments on the command line.
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A.3 Control Characters
Table A–2 shows the format for control characters in DDSF scripts.

Table A–2 DDSF Control Characters

Control
Character

Character
Format

Control
Character

Character
Format

NUL ^@ DLE ^P

SOH ^A DC1 ^Q

STX ^B DC2 ^R

ETX ^C DC3 ^S

EOT ^D DC4 ^T

ENQ ^E NAK ^U

ACK ^F SYN ^V

BEL ^G ETB ^W

BS ^H CAN ^X

HT ^I EM ^Y

LF ^J SUB ^Z

VT ^K ESC ^[

FF ^L FS ^\

CR ^M GS ^]

SO ^N RS ^^

SI ^O US ^_

NOTE: There is no implied CR at the end of commands. Therefore, if a command requires
processing by the modem software, send a CR (carriage return) character after the command.
In general, you do not need a CR after commands that pass control or assign values within the
dialer script. For example, the ^M in the next set of commands is necessary to dial the phone
number:

SEND "ATDT"
SEND PHONENUMBER
SEND "^M"

The following commands do not require a CR:

WAITFOR 60 RESPONSE SIZE=40 TERM=8192
IF TIMEOUT RETURN TIME_OUT

A.3.1 Sending the Circumflex Character
If you need to send a circumflex (^) by itself followed by an uppercase letter, make
it two strings. For example, to send an ^ and an M:

SEND "^"
SEND "M"

A.4 Numeric Values
All numeric values specified within the script file must be in decimal (base 10)
notation. The command parser does not recognize hexadecimal, octal, or binary
numbers.
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A.5 DDSF Script Commands
The next sections describe these DDSF script commands:

• FIND

• GOTO

• IF

• INCREMENT

• LET

• ON...GOTO

• PURGE

• RETURN

• SECTION

• SEND

• SET

• WAITFOR

• WAITSTRING

• ZERO

The commands are case insensitive.
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FIND

Description

The FIND command searches the RESPONSE buffer for the specified string and
sets the FOUND and NOTFOUND flags accordingly. The maximum length of the
text string is 80 characters. If the data in the RESPONSE buffer contains the
text string, a match occurs. Null strings always set the FOUND flag.

Syntax

FIND parameter

Parameters

"string-constant"
The match string pattern used or string keyword to search for in the RESPONSE
buffer. Enclose the string in quotation marks ("string-constant").

PARAMn
Equates to the internal parameters param1, param2, or param3.

Examples

1. FIND "Ready"

This command searches the RESPONSE buffer for the string "Ready".

2. FIND PARAM1

This command searches the RESPONSE buffer for the PARAM1 string.
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GOTO

Description

The GOTO command moves the processor to the command section specified by
the value of n. If you do not declare a section for n, an error is returned. The
maximum number of section labels is 20.

Syntax

GOTO n

Parameter

n
The script section entry point for the branch.

Example

GOTO 2

This command branches to location SECTION 2 in the script file.
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IF

Description

The IF command tests one of several conditions and performs a logical execution
flow control.

Syntax

IF condition action

Conditions

RESPONSE="text"
A 512-character buffer where modem responses are stored. Use the RESPONSE
parameter to test whether the RESPONSE buffer contents are equal to the
specified text string.

[NO]TIMEOUT
A DDSF Boolean expression whose value is determined whenever a WAITFOR
command is processed. If the specified time period expires before completion of
the WAITFOR command, this Boolean expression becomes TRUE; otherwise, it is
FALSE. Use this parameter to test whether the last WAITFOR command resulted
in a timeout.

[NOT]FOUND
A DDSF Boolean expression whose value is determined whenever a FIND
command is processed. If the text string specified in the FIND command is
located within the response buffer, the FOUND Boolean expression becomes
TRUE; otherwise, it is FALSE. Use this parameter to test whether the last FIND
command was a success or failure.

COUNTERn ( <, >, =, <>, <=, >=) numeric_value
One of several DDSF counters. These counters can be used to create looping
algorithms within the structure of a script file. There are five counters:
COUNTER1 through COUNTER5. Use this parameter to compare the counter
contents with the specified numeric value, according to the specified relational
operator.

PARAMn="text"
Equates to the internal parameter param1, param2, or param3.
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Actions

GOTO n
If the condition is TRUE, branch to the specified script section (n).

LET PARAMn="string"
If the condition is TRUE, assign the string to parameter n.

RETURN exit-keyword [SPEED integer] [PROTOCOL "string"]
If the condition is TRUE, return to the caller with the specified exit-keyword and
optional SPEED and PROTOCOL values. See the RETURN command description
for more details.

Examples

1. IF RESPONSE="r^M" GOTO 3

This command compares the RESPONSE buffer to the "r^M" string. If the
string matches, go to SECTION 3.

2. IF COUNTER1>=3 RETURN DIAL_ERR

This command compares the value of COUNTER1 with 3. If they are equal,
then return DIAL_ERR status to the application.

3. IF FOUND RETURN CONNECT SPEED 9600 PROTOCOL "None"

This command checks the FOUND flag value. If the value is TRUE, then
return the CONNECT status to the application with speed 9600 and protocol
"None".
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INCREMENT

Description

The INCREMENT command adds 1 to the current value of an internal counter
COUNTERn. This command, with IF and GOTO commands, is usually used for
loop control.

Syntax

INCREMENT COUNTERn

Parameter

COUNTERn
Specifies one of the DDSF counters to be incremented. Use these counters to
create looping algorithms within the structure of a script file. There are a total of
five counters: COUNTER1 through COUNTER5.

The counters can be initialized with the LET or ZERO commands.

Example

INCREMENT COUNTER1

This command increments the keyword COUNTER1.
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LET

Description

The LET command allows you to set any counter to a known (or base) value.
It assists in the creation of states within the script when used with the ON
COUNTER GOTO command. Counter values cannot exceed 65535.

Syntax

LET COUNTERn = y

Parameters

COUNTERn
Specifies one of several DDSF counters to be set. You can use these counters to
create looping algorithms within the structure of a script file. There are a total of
five counters: COUNTER1 through COUNTER5.

y
The decimal value for the counter.

Example

LET COUNTER1=5

This command sets COUNTER1 to the value 5.
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ON...GOTO

Description

The ON...GOTO command is used to perform computed branches within the
execution of a script. Script execution branches to the section (x) whose position
in the destination list corresponds to the value in the specified counter. An error
occurs if the contents of the specified counter exceed the number of sections in the
destination list. If the counter contains 0, execution continues with the command
that follows the ON...GOTO command.

Syntax

ON COUNTERn GOTO x1 x2 x3...x10

Parameters

COUNTERn
Specifies one of several DDSF counters to be tested. You can use these counters
to create looping algorithms within the structure of a script file. There are a total
of five counters: COUNTER1 through COUNTER5.

x1 x2 x3...x10
A destination list of valid sections that exist within the script. You can specify
a maximum of 10 sections. Sections can appear more than once and in any
order within the destination list. Entries in the destination list are separated by
spaces.

Example

ON COUNTER1 GOTO 5 6 7

In this command, if the value in COUNTER1 is 1, execution branches to
SECTION 5. If COUNTER1 contains a 2, execution branches to SECTION 6,
and so on.
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PURGE

Description

The PURGE command clears the terminal-to-modem communications channel
of any unread modem responses. Purging does not affect data already in the
RESPONSE buffer.

Syntax

PURGE

Example

PURGE

This command clears the DDSF type-ahead buffer.
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RETURN

Description

The RETURN command causes the DDSF processor to do the following
procedures, usually in this order:

• Stop processing the DDSF script file

• Assign the optional speed and/or protocol values in the DDSF status block

• Return control to DSNlink with a status code

Syntax

RETURN exit_keyword [SPEED integer] [PROTOCOL "string"]

Parameters

exit_keyword
The exit keywords equate to predefined result values. You can assign these
values to the DDSF return status block through the RETURN command. The
valid exit keywords are listed in Table A–3.

Table A–3 Valid Exit Keywords

Keywords Description DDSF Return Status

BUSY DDSF detected target line busy DDSF_S_BUSY
CALL_FAIL DDSF failed to establish the

connection
DDSF_S_CALLFAIL

CONNECT Connection established DDSF_S_CONNECT
DIAL_ERR DDSF sensed device problem when

trying to dial
DDSF_S_DIALERR

NO_ANSWER DDSF detected no answer DDSF_S_NOANSWER
NO_DIALTONE DDSF detected no dial tone DDSF_S_

NODIALTONE
TIME_OUT DDSF timed out without getting

modem status
DDSF_S_TIMEOUT

[SPEED integer]
If a SPEED value is specified, it will be put into the speed field of DDSF status
block and returned to the calling application.

The speed can be any positive integer. Common SPEED values include 300, 1200,
2400, 4800, 9600, and 19200 baud.

[PROTOCOL "string"]
If a PROTOCOL value is specified, it will be put into the protocol field of DDSF
status block and returned to the calling application. DDSF does not check the
"string" value, so you can put any value into the "string." The maximum length is
20.
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Examples

1. RETURN DIAL_ERR

This command returns to the application with exit status DDSF_S_DIALERR.

2. RETURN CONNECT SPEED 2400

This command returns to the application with exit status DDSD_S_
CONNECT, and puts 2400 into the speed field of the DDSF status block.

3. RETURN CONNECT PROTOCOL "MNP"

This command returns to the caller with exit status DDSF_S_CONNECT, and
puts "MNP" into the protocol field of the DDSF status block.

4. RETURN CONNECT SPEED 9600 PROTOCOL "Reliable"

This command returns to the caller with exit status DDSF_S_CONNECT,
and puts 9600 into the speed field, and "Reliable" into the protocol field of the
DDSF status block.
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SECTION

Description

The SECTION command creates the script command sections by defining entry
points within the script file. All SECTION keywords must be followed by a
unique number in the range of 1 to 20.

Syntax

SECTION n

Parameter

n
A unique integer in the range of 1 to 20.

Example

SECTION 1

This command marks the code that follows it as belonging to SECTION 1, similar
to the way a label is used in standard programming languages. Hence, a GOTO
1 command causes script execution to resume at the first line that follows the
SECTION 1 entry point.
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SEND

Description

The SEND command lets you send a string parameter to the modem. If you
specify a script string keyword, the DDSF script processor sends the contents of
the string keyword to the modem.

Syntax

SEND parameter

Parameters

"string-constant"
A text string enclosed in double quotation marks ("").

PARAMn
Equates to the internal parameters param1, param2, or param3.

PHONENUMBER
The telephone number of the DSNlink host after any conversions by the telephone
number substitution database.

For more information on the telephone number substitution database, see the
chapter on Maintaining DSNlink in the DSNlink Version 2.1 User’s Guide. (This
is an online document accessible from the Help menu on the DSNlink main
window or by using the dsnhelp command.)
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Examples

1. SEND "^B"

This command sends a Ctrl+B character to the modem.

2. SEND "12345678"

This command sends a text string "12345678" to the modem.

3. SEND PARAM1

This command sends the string in the PARAM1 keyword to the modem.

4. SEND PHONENUMBER

This command sends the string in the PHONENUMBER keyword to the
modem.
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SET

Description

Used mainly as a script debugging tool, this option enables and disables the
display of text strings received from or sent to the modem.

Syntax

SET parameter

Parameters

DISPLAY ON/OFF/FULL

The SET DISPLAY ON and SET DISPLAY FULL commands display data sent
to modem through SEND commands, and data received from modem through
WAITFOR commands. The SET DISPLAY OFF command disables this feature.

Examples

1. SET DISPLAY FULL

This command enables the DDSF debugging option.

2. SET DISPLAY OFF

This command disables the DDSF debugging option.

Dialer Driver Script Facility Commands A–17



WAITFOR

WAITFOR

Description

The WAITFOR command provides a mechanism for specifying a time period
during which the processor waits for a given event to occur. The event can be a
certain number of characters are received, or a terminate character is detected.

When an event is detected within the timeout period, the time_out variable is
assigned the value FALSE. Otherwise, time_out is assigned the value TRUE.

You can also use WAITFOR as a simple delay mechanism if you specify a time_
out parameter without an associated event.

Syntax

WAITFOR time_out [RESPONSE] [SIZE=integer] [TERM=integer]

Parameter

time_out
This parameter specifies the maximum time in seconds the WAITFOR command
is executed.

RESPONSE
This is an optional keyword for syntax clarity.

SIZE=integer
This parameter specifies the maximum number of characters to accept by the
WAITFOR command. When it is reached, the command exits.

Be sure the size is equal to or larger than the number of characters that are
likely to be in the RESPONSE buffer.

TERM=integer
This parameter specifies a 32-bit, unsigned integer mask to be the terminator
of the WAITFOR command. Each bit corresponds to one ASCII character: bit 0
corresponds to ASCII 0, and so on. Specify the mask in decimal. A value of zero
means no terminators.

If you want the terminators to be a control character, such as ^M (CR), assign its
value to TERM parameter. For example, ^M is equal to 213 or 8192. The ^J (LF)
control character has a value equal to 210 or 1024.
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Examples

1. WAITFOR 4 RESPONSE SIZE=20 TERM=8192

This command waits a maximum of 4 seconds for either 20 characters or a
CR (213) terminator received from the modem.

2. WAITFOR 10 RESPONSE TERM=1024

This command waits a maximum of 10 seconds for a LF (210) terminator
received from the modem.

3. WAITFOR 40

This command waits 40 seconds then continues with next command.

4. WAITFOR 30 RESPONSE TERM=9344

This command waits 30 seconds for the BEL, LF, and CR terminators. The
value of TERM is the combined values of BEL (128), LF (1024) and CR (8192).
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WAITSTRING

Description

The WAITSTRING command replaces the <wait> tag in the PHONENUMBER
buffer with the "string" provided and leaves the result in the PHONENUMBER
buffer.

Syntax

WAITSTRING "string"

Parameter

"string"
The "string" is composed of any valid wait characters that the modem can
interpret.

Examples

1. WAITSTRING ",,,"

The <wait> tag in PHONENUMBER buffer is replaced by ",,," in this
command. This command can be used in the DDSF script for Hayes modems.

2. WAITSTRING "="

The <wait> tag in PHONENUMBER buffer is replaced by "=" in this
command. This command can be used in the DDSF scripts for DF196
and DF296 modems.

See your modem’s specifications for what to use for the value of "string."
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ZERO

Description

The ZERO command resets a specified counter (COUNTER1 to COUNTER5) to
zero.

Syntax

ZERO COUNTERn

Parameter

COUNTERn
The internal counter that will be initialized to zero.

Example

ZERO COUNTER1

This example initializes the keyword COUNTER1 to a value of zero.
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DSNlink Directories on Your System

This appendix lists:

• Directories used by DSNlink

• Directories created by DSNlink

• Files modified by the DSNlink installation procedure

Table B–1 lists the directories used by DSNlink.

Table B–1 Directories Used by DSNlink

Directory Name Description

/usr/bin/ Links for command names

/usr/sbin/ Links for system administrator

/usr/lib/x11/app-defaults Links to the resource files for the applications running
in the DECwindows Motif interface

/usr/lib/x11/uid Links to the UID files

/usr/share/man/man1 Links for reference pages

/usr/share/man/man4 Links for reference pages

/usr/share/man/man8 Links for reference pages

Table B–2 lists the DSNlink directories, which are created during the installation
procedure.

Table B–2 DSNlink Directories Created by the DSNlink Installation

Directory Name Description

/usr/opt/DSNA300/app-defaults Resource files for the applications running in the
DECwindows Motif interface

/usr/opt/DSNA300/bin.alpha Commands

/usr/opt/DSNA300/doc ElectronicServiceToolsLicenseAgreement.txt

/usr/opt/DSNA300/help The online documentation help files

/usr/opt/DSNA300/man The reference pages

/usr/opt/DSNA300/msg Message files

/usr/opt/DSNA300/uid.alpha UID files for DSNlink applications running in the
DECwindows Motif interface

(continued on next page)
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Table B–2 (Cont.) DSNlink Directories Created by the DSNlink Installation

Directory Name Description

/var/opt/DSNA300/config
alias: /usr/lib/dsn/config/

Configuration files:

• .dsnrc — the systemwide configuration file, also
referred to as the resource file

• dsn_local_auth.dat — authorizations file for
DSNlink users at your site

• dsn_remote_auth.dat — authorizations file to
allow Compaq specialists access to your DSNlink
systems

• dsn_sra_signature.txt — the signature file that is
appended to service requests

• routemap — the DSNlink route map, which
has paths for connections between your site
and Compaq. (Do not edit this file. Make any
additions or changes through the DSNlink Setup
utility.)

routemap-sorted — is a sorted version of the route
map, which reduces the access time for a large
route map.

• Template files:

• .template...dsnrc

• .template..dsn_local_auth.dat

• .template..dsn_remote_auth.dat

• .template..routemap and .template..routemap-
sorted — the route map template has entries
for all Customer Support Centers. (Do not
edit this file. DSNlink uses it for route map
generation and rebuilding.)

/var/opt/DSNA300/keys
alias: /usr/lib/dsn/keys/

Cryptographic keys. (Keep the contents of the files
confidential.)

/var/opt/DSNA300/logs
alias: /usr/lib/dsn/logs/

Application log files:

• dsn_history.log — records of each use of DSNlink
applications

• *.log — log files created by incoming DSNlink
applications and the modem transport

(continued on next page)
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Table B–2 (Cont.) DSNlink Directories Created by the DSNlink Installation

Directory Name Description

/var/opt/DSNA300/modem
alias: /usr/lib/dsn/modem/

Files related to modems:

• *.ddsf_src files — modem dialer scripts

• dsn_modem_devices.dat — modem settings
established during the installation procedure

• dsn_modem_instantiate.dat — links to the
commands that start Compaq-to-customer
application servers

• dsn_modem_lines.dat — shared variables for the
modem line. Do not edit this file.

• dsn_modem_servers.dat — shared variables for
modem server processes. Do no edit this file.

• dsn_modem_substitution.dat — dialing
information and conventions

• Template files:

• .template..dsn_modem_devices.dat

• .template..dsn_modem_instantiate.dat

• .template..dsn_modem_substitution.dat

/var/opt/DSNA300/public
alias: /usr/lib/dsn/public/

Contains files copied to or from your system by
Compaq. It has two directories:

• incoming — files copied from Compaq to your
system

• outgoing — not used

/var/opt/DSNA300/spool Not used

/var/opt/DSNA300/stumps Not used

Table B–3 lists the files that are modified by the installation procedure.

Table B–3 Files Modified by the DSNlink Installation

File Description of Modification

/var/adm/sendmail/aliases Added DSNlink mailing lists

/etc/services Added ports used by DSNlink applications

/etc/inetd.conf Added servers for DSNlink
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deinstalling, 1–10
directories, B–1
documentation set, v
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Installation Guide, 3–2
installing, 2–1
kit contents, 1–2
overview, v
Quick Reference Card, 3–2
Release Notes, 3–2
Service Tool Description, 3–2
starting, 3–15

DSNlink Setup Utility, 3–8

E
Encryption

changing ciphers to communicate with a V2.2
host, 3–7

Errors
correcting with DSNlink Setup utility, 3–8
installation, 1–13
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ESR routing code
defining, 3–4

F
Files

authentication key, 2–18
configuration, 3–4
DSNlink, B–1
log, 3–14
modified by DSNlink, B–3
saved from deletion by deinstallation, 1–12
signature file, 2–19
/usr/lib/dsn/config/.dsnrc, 3–4

FIND command, A–3
Firewalls

changing to single-port mode, 3–14

G
GOTO command, A–5
Group

creating for DSNlink files, 1–4

H
Hardware

required to install, 1–5

I
IF command, A–6
INCREMENT command, A–8
Installation

cluster requirements, 1–3
disk space requirements, 1–6
errors, 1–13
example, 2–1
group for DSNlink files, 1–4
hardware requirements, 1–5
help on the procedure, 2–12
login privileges, 1–4
nonencrypted version, 2–12
notes for modem transport, 1–10
overview, 1–1
recommendations, 1–1
restrictions, 1–1
software requirements, 1–5
stopping, 1–13
time required, 1–4

Installation Verification Procedure
failure, 2–19
running, 3–8

K
Kit

contents, 1–2

L
LET command, A–9
Local authorizations file, 3–2
Local domain, 2–14
Log files, 3–14
Login

allowing Compaq access to your system, 3–3

M
Mail messages

forcing to a specified node, 3–6
from Compaq, 3–5
signature file, 3–8

MNP
requirement for modems, 1–5

Modems
changing configuration, 3–9
hardware requirement, 1–5
MNP requirement, 1–5
notes for installation questions, 1–10

Modem scripts
creating or modifying scripts, 3–10
dialer script commands, A–1
guidelines for scripts, 3–12
supplied scripts, 3–10
Web site for updates, 3–11

N
Node A or Node C

changing to Node B, 2–15
Node B

changing to Node A or Node C, 2–15
Node name

changing, 3–9
Node type

changing, 3–9

O
ON...GOTO command, A–10
Operating system

requirements, 1–5

P
Parameters

See DECserver parameters

Index–2



Ports for TCP/IP, 1–9
Postinstallation tasks, 3–1
Preinstallation requirements, 1–3
PURGE command, A–11

R
Receiver nodes, 3–6
Recommendations

installation, 1–1
rehash command, 2–19
Release notes, 1–2, 3–2
Remote authorizations file, 3–3
Restrictions

installation, 1–1
RETURN command, A–12
RIS client installation, 1–3
Routing codes

defining, 3–4

S
Secret key

see Authentication key, 2–1
SECTION command, A–14
SEND command, A–15
Service Request application

people to copy on submissions, 3–5
SET command, A–17
Setup utility

See DSNlink Setup Utility

Signature files
creating, 3–8
prompts for, 2–19

Single-port firewalls, 3–14
SRA.CC parameter, 3–5
Subsets

DSNlink, 1–6
required for Tru64 UNIX, 1–5

T
TCP/IP

changing configuration, 3–9
ports, 1–9

Tru64 UNIX
required version, 1–5
sample installation, 2–2

U
Unrecognized DSNlink commands, 2–19

W
WAITFOR command, A–18
WAITSTRING command, A–20
WorldWire

using with DSNlink, 1–7

X
X.25

changing configuration, 3–9
deleting the NCL configuration, 1–12

Z
ZERO command, A–21
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